


99

4.5  Predicting Downstream Pollutant Concentrations in Watershed Stream

       Networks

Pollutant concentrations that are sampled at various in-stream locations result

from the mixing of all pollutant-laden flows draining from upstream of the particular

location.  For a digitally discretized grid model, this mixing process is approximated by

dividing the accumulated load at each cell by the accumulated runoff that also occurs

there.  Mathematically, this is represented by

Ca = La / Qa, (4-7)

where La is the annual cumulative loading, Qa is the annual cumulative runoff, and Ca is

the average concentration expected at the location.

These predicted concentration values can be compared with measured data

from a sampling program in order to assess the accuracy of the predicted values.  For

this study the water quality measurement data described in section 3.2 are used for

comparison.  For each sampling location in the data set, the assumption is made that the

expected observed concentration is simply the average of all the measurements made

there, or

                      n

     Co =  (1/n) * Σ Ci ,     (4-8)
                                  i=1

where Ci is each concentration value measured at a particular sampling location, n is

the total number of samples made at that location, and Co is the average observed

concentration.

Estimating Average Concentrations

Before estimated concentrations can be calculated, grids of annual cumulative

loading and annual cumulative runoff need to be established.  Grids of annual

cumulative loading are created as per the procedure in section 4.4.  Annual cumulative

runoff is created by performing a weighted flow accumulation, using the runoff grid as
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the weight grid.  The result of the weighted flow accumulation is multiplied by 10 to

convert from runoff units of mm/yr to accumulated units of m3/yr, as in equation 4-1.

Grid:  runoffac = flowaccumulation(mainfdr,runoff) * 10
Grid:  describe runoffac

By performing a Describe command on the cumulative runoff grid, the

maximum value of the grid is determined as more than 290 million m3/yr.  This is the

value at the outlet of the Mission River to Mission Bay.  The equivalent annual

cumulative runoff grid, in units of cubic feet per second (cfs), is calculated by

multiplying the runoffac grid by the number of cubic feet per cubic meter and dividing

by the number of seconds per year.  In these units of measure, the annual cumulative

runoff is represented as an average stream flow and is more easily compared with

recorded USGS stream flow values.  For display purposes, an equivalent coverage of

the accumulated runoff grid is created by first converting the real number grid to an

integer grid.  Then the Streamline command is used, along with the Con statement, to

create arcs for all cells having value greater than or equal to a certain threshold value,

specified so that only in-stream cells are converted.  For this conversion, the threshold

value is chosen to be 1 cfs.  The cumulative runoff coverage is then clipped with the

mainland coverage to create cumulative runoff arcs that end exactly at the boundaries

of the bay network.  Figure 4.16 shows average stream flows in units of cubic feet per

second.

Grid:  rofaccfs = runoffac * 35.2875 / 31557600
Grid:  introfac = int(rofaccfs)
Grid:  rofaclin = streamline(con(introfac >= 1,introfac),mainfdr,grid-code)
Arc:  clip rofaclin mainland rofaccov line

Once the annual cumulative runoff grid is created, a grid of predicted pollutant

concentration can be created as per equation 4-7.  Using total phosphorus as an

example pollutant, a grid of predicted concentrations is produced by dividing the

annual total phosphorus cumulative load grid by the annual cumulative runoff (m3/yr)

grid.  Multiplication of this result by 1000 produces a concentration grid in units of

mg/L as per the equation

C (mg/L)  =  L (kg/yr) / Q (m3/yr) * 106 mg/kg * .001 m3/L.     (4-9)
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A grid of concentration values specific to the basin stream network is

established using the Con statement with the introfac grid created above. Values from

the predicted total phosphorus concentration grid are filled into those cells that

correspond to locations along the stream networks.  Since arc coverages may only be

converted from integer value grids, the stream concentration grid is multiplied by 1000

to retain significant figures, the product is truncated to create the integer grid, and the

resulting grid is converted to a coverage, using the Streamline command.  Finally, the

phosphorus concentrations arc coverage is clipped so that the concentration arcs end

exactly at the shores of the bay network.

Grid:  phosconc = phosload / runoffac * 1000
Grid:  phconstr = con(introfac >= 1,phosconc)
Grid:  phline = streamline(int(phconstr * 1000),mainfdr,grid-code)
Arc:  clip phline mainland phcon line

Figure 4.17 shows the predicted concentrations for total phosphorus in the San

Antonio-Nueces coastal basin.  These predicted concentrations represent the levels of

pollution that are attributed to nonpoint source runoff, only.  Additional point source

pollutant loadings are considered in section 4.6.

Attaching Observed Concentration Data to Measurement Locations

The Surface Water Quality Monitoring (SWQM) data described in section 3.2

are used for comparison with the predicted concentration values.  With the data linked

in ArcView 2.0 as shown in Figure 3.11, the average measured value of a particular

pollutant constituent is established through use of the Summary Statistics tool.  First, a

pollutant is selected in the storet.dbf table.  Then, with the station_id field selected in

the value.dbf table, the Summary Statistics tool is invoked.  This tool allows the user to

sort and manipulate data from the selected table, using the previously selected field to

sort by.  Using the tool, the Value field is specified as the data to manipulate and the

Summary Statistics Averaging function is performed on the data.  This process creates a

new database file (.dbf) that includes three fields:  (1) all station-id’s reporting data for

the particular pollutant, (2) a field called count that represents the total number of

measurements of the pollutant at that station, and (3) a field called ave_value that





104

represents the mean value of the specified measurements.  Table 4.6 shows a portion of

the tp.dbf file identifying all measurement locations where total phosphorus is

measured, the number of measurements at each location, and the average

concentrations at each location.

The tp.dbf file is attached to the water quality measurement stations point

coverage in Arc/Info.  First, the file is converted to an Arc/Info Information file (.dat)

using the Dbaseinfo command.  The new tp.dat file is then attached to the sanwq point

attribute table using the Joinitem command with the station_id field specified as the link

item.  Using the Arc/Info Tables module, the new count and ave_value fields of the

sanwq point attribute table are altered to have the more definitive tp_cnt and tp_avg

field names.

Arc:  dbaseinfo tp.dbf tp.dat
Arc:  joinitem sanwq.pat tp.dat sanwq.pat station_id station_id
Arc:  tables
Enter Command:  sel sanwq.pat
   105 Records selected
Enter Command: alter
Enter item name: count
COLUMN   ITEM NAME        WIDTH OUTPUT  TYPE N.DEC  ALTERNATE NAME
   22  COUNT                   8     11     F      0
Item name: tp_cnt
Item output width: 11
Item type: f
Item decimal places: 0
Alternate item name: ~
COLUMN   ITEM NAME        WIDTH OUTPUT  TYPE N.DEC  ALTERNATE NAME
   22  TP_CNT               8    11     F      0
Enter item name: ave_value
COLUMN   ITEM NAME        WIDTH OUTPUT  TYPE N.DEC  ALTERNATE NAME
   30           AVE_VALUE              8     16     F      2
Item name: tp_avg
Item output width: 16
Item type: f
Item decimal places: 2
Alternate item name: ~
COLUMN   ITEM NAME        WIDTH OUTPUT  TYPE N.DEC  ALTERNATE NAME
   30  TP_AVG                8   16     F     2
Enter item name:   ~

 Enter Command:  quit
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STATION_ID COUNT AVE_VALUE

12932 2 0.61
12933 5 6.60
12934 1 7.36
12935 6 6.28
12937 2 6.61
12938 2 5.94
12939 2 4.26
12940 2 4.22
12941 1 0.25
12942 1 0.16
12943 27 0.15
12944 75 0.06
12945 27 0.14
12946 1 0.28
12947 2 0.50
12948 39 1.09
12949 2 1.73
12950 1 2.19
12951 2 2.91
12952 3 4.47
12953 1 3.01
13030 1 0.14

: : :
: : :

Table 4.6 :  Summary Statistics for Total Phosphorus
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The procedure of using the ArcView Summary Statistics tool and attaching

average concentration values to the sanwq point attribute table is repeated for each

pollutant constituent of interest (i.e. those pollutants identified in Table 3.6).  Nitrogen,

however, is not sampled and reported as total nitrogen in the Surface Water Quality

Monitoring data set.  Instead, total kjeldahl nitrogen (organic plus ammonia nitrogen),

nitrate nitrogen, and nitrite nitrogen are reported separately.  These are the components

that total nitrogen is comprised of (American Public Health Association, American

Water Works Association and Water Environment Federation, 1992).  Each of the

three nitrogen components is summarized, averaged, and attached to the sanwq point

attribute table along with the other pollutant constituents from Table 3.6.  Then two

additional fields, tn_cnt and tn_avg, are added to the point attribute table using the

Joinitem command.  In the Tables module, the number of effective total nitrogen

measurements at each location is determined as the average of the number of

measurements for each component.  The average value for total nitrogen concentration

at each location is determined as the sum of the average values for each component.

Finally, X- and Y-coordinate values are added to each record in the sanwq point

attribute table through use of the Addxy command:

Arc:  additem sanwq.pat sanwq.pat tn_cnt 8 8 f 0
Arc:  additem sanwq.pat sanwq.pat tn_avg 8 8 f 2
Arc:  tables
Enter Command:  sel sanwq.pat
   105 Records selected
Enter Command:  calc tn_cnt = ( tkn_cnt + no2_cnt + no3_cnt ) / 3
Enter Command:  calc tn_avg = tkn_avg + no2_avg  + no3_avg
Enter Command:  quit
Arc:  addxy sanwq

Analyses of the Surface Water Quality Monitoring data at specific locations and

for specific pollutants reveal some interesting points.  Figure 4.18 shows all of the total

phosphorus measurements taken at station #12948 along the Aransas River about 15

kilometers upstream of Copano Bay.  By plotting these concentration levels against the

sampling dates, the variations in concentration magnitude are plainly seen.  A plot of

the average concentration overlaid on the data shows the effect of a few elevated

concentration measurements on the average value and suggests that consideration and
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possible removal of outlying data points may be appropriate for determination of a

revised average.

Figures 4.19 and 4.20 respectively show the nitrogen component measurements

made at the Aransas station and at station #12944 along the Mission River about 10

kilometers upstream of Mission Bay.  Each of these plots also shows the value for total

nitrogen, calculated as the sum of the average total kjeldahl, total nitrate, and total

nitrite levels.  Values for total kjeldahl and total nitrite nitrogen generally fall into fairly

well-bounded ranges, but nitrate nitrogen concentration values, particularly at the

Mission River station, show an occasional tendency to vary significantly from the

normal range.  These atypical measurements have a significant effect on the calculated

average total nitrate concentration which, in turn, affects the calculation of average

total nitrogen concentration.  In fact, the single outlying total nitrate concentration data

point observed at the Mission station (Figure 4.20) affects the calculated average total

nitrate concentration by almost 200%, increasing it from about 0.077 mg/L to 0.22

mg/L.  As a result, average total nitrogen calculated for the station is 18% higher than it

would be without inclusion of the anomalous data point.  This point emphasizes that

outlying data points should be considered when establishing averaged values for

pollutant concentration at a particular location.

A second point of interest regarding the Surface Water Quality Measurement

nitrogen data is illustrated in Figure 4.21, which shows the percentile distributions, for

both the Aransas and Mission stations, of the three components that contribute to the

calculated average total nitrogen concentrations.  The charts in this figure have been

determined using all data points from each of the stations, i.e. without consideration

and removal of outlying data points.  The chart shows that, for both locations, most of

the total nitrogen observed is of an organic nature.  The oxidized forms of nitrogen

account for only 25-30% of the total observed (before consideration of outlying

points).  Organic and ammonia nitrogen is typically associated with agricultural land

uses and the fact that kjeldahl nitrogen accounts for over 70% of the total nitrogen

measured in the two main streams of the basin indicates a significant contribution from

the local agricultural lands.
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Graphically Depicting Variations in the Frequency of Concentration Sampling

The average concentrations that are attached to the water quality measurement

points are calculated by averaging various numbers of measurements.  In fact, for total

phosphorus, Table 4.6 shows one average concentration derived from 75 measurements

while a number of locations have only one measurement defining average

concentration.  One would be correct in placing more statistical validity in those

averages derived from larger numbers of measurements.

A method of depicting this variation in the number of concentration

measurements is established by converting the water quality measurement point

coverage into a polygon coverage of circles, where each circle is centered about the

measurement location coordinates and each circle’s area is approximately proportional

to the number of measurements made at the station.  This is done by (1) adding a radius

field to each record in the sanwq point attribute table, (2) calculating values for radius

based on the number of measurements for the pollutant constituent of interest, (3)

creating a text-delimited data file from the station-id, x-coordinate, y-coordinate, and

radius fields, (4) generating a polygon coverage from the data file, and

(5) attaching the pollutant measurement data to the new polygon coverage.

The first three of these steps are performed in ArcView 2.0:  For the case of

total phosphorus measurements, the sanwq point attribute table is displayed and the

Properties feature in the Table menu is used to deselect all fields except for station_id,

x-coord, y-coord, and tp_cnt.  The Table menu is used once again to Start Editing of

the table.  The Add Field feature from the Edit menu is then invoked and the Radius

field is defined as an 8-character numeric item.

The Calculate feature of the Field menu is used to specify that values in the

Radius field are determined as the truncated square root of the tp_cnt field multiplied

by 200 meters, or

Radius = tp_cnt.sqrt.truncate * 200.     (4-10)

The value of 200 meters is selected, by trial and error, as the smallest radius that

produces a discernible circle for single measurement stations, while maintaining a

reasonably sized circle for locations with many measurements.  By taking the square
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root of the number of pollutant measurements, the area of the circle (π * radius2) is

made proportional to the number of measurements.  Once the values for the Radius

field are filled, the Stop Editing feature is selected from the Table menu.

The Properties feature in the Table menu is used to deselect the tp_cnt field

from the sanwq point attribute table, leaving only the station-id, x-coord, y-coord, and

radius fields displayed, in that order.  The Export feature from the File menu is then

invoked to create a text-delimited file containing the values of these four fields.  A

portion of this text-delimited file, called rad.txt, is shown in Figure 4.22.

A raw data file (rad.dat) is created from this text-delimited file by removing the

column labels in the header and appending the bottom of the file with an END

statement.  This raw data file is then used in conjunction with the Arc/Info Generate

command to create a coverage of circles at each measurement location.  Polygon

topology is created through use of the Clean command:

Arc:  generate phospts
Generate:  input rad.dat
Generate:  circles
   Creating Circles with coordinates loaded from rad.dat
Generate:  quit
   Externalling BND and TIC.......
Arc:  clean phospts phopts

Finally, water quality measurement data is attached to the phopts coverage by

adding an integer field called station_id to the phopts polygon attribute table, filling

those fields with the values from the phopts-id field, altering the station_id field to

character type, and performing a Joinitem command with the tp.dat file, using the

station_id field to join the two files.

Arc:  additem phopts.pat phopts.pat station_id 5 5 i
Arc:  tables
Enter Command:  sel phopts.pat
     24 Records selected
Enter Command:  calc station_id = phopts-id
Enter Command: alter
Enter item name: station_id
COLUMN   ITEM NAME        WIDTH OUTPUT  TYPE N.DEC  ALTERNATE NAME
  17         STATION_ID                5      5     I      -
Item name: station_id
Item output width: 5
Item type: c
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"Sanwq-id","X-coord","Y-coord","Radius"
12931,1253025.250,696013.875,0
12932,1222723.500,694795.125,200
13399,1321153.000,694116.750,0
12933,1223832.250,693739.500,400
12934,1224645.625,693725.188,200
12936,1223313.875,693697.688,0
12935,1225518.375,693651.250,400
12937,1226820.250,692784.062,200
12939,1226039.375,690734.125,200
12938,1226287.000,690616.125,200
13660,1282946.625,685779.625,800
12942,1225275.500,685540.438,200
12944,1266646.625,684073.938,1600
12940,1227986.625,682454.125,200
12952,1233187.250,682256.125,200
12953,1230096.875,681881.750,200
12941,1226212.125,681493.000,200
13398,1315794.250,678917.375,0
12951,1242619.250,676083.625,200
13401,1309669.875,673810.625,0
13406,1299136.750,672437.562,0
12943,1273454.375,672223.500,1000
13400,1307925.750,670925.375,0
12950,1242018.500,670924.062,200
12949,1249132.375,668866.188,200
13404,1292647.500,666251.562,0
12948,1252749.000,665714.812,1200
     :             :             :            :
     :             :             :            :
     :             :             :            :

Figure 4.22 :  Text-Delimited File of Water Quality Measurement Radii
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Alternate item name: ~
COLUMN   ITEM NAME        WIDTH OUTPUT  TYPE N.DEC  ALTERNATE NAME
   17         STATION_ID     5     5     C      -
Enter item name: ~
Enter Command:  quit
Arc:  joinitem phopts.pat tp.dat phopts.pat station_id station_id

This procedure is performed for each pollutant constituent of interest.

However, since no .dat file exists for total nitrogen, the polygon attribute table for that

coverage of circles is joined with the sanwq point attribute table, which contains the

average values for all pollutant constituents of interest.  The sanwq point attribute table

is actually an alternative source of average concentration data for all of the circle

coverages.

Figure 4.23 shows the predicted total phosphorus concentration data overlaid

with the phopts polygons.  For display purposes, these circles are provided with a label

of the average concentration at the location concatenated with the number of total

phosphorus measurements.  This label is created in ArcView 2.0 by adding a new

character field and, using ArcView’s internal Avenue programming language, defining

the contents of the character string as

[pho_tag] = [tp_avg].SetFormat(“d.dd”).AsString ++
”(“ ++ [tp_cnt].AsString ++ ”)”, (4-11)

where .AsString converts the value of the preceding variable to a character string and

.SetFormat(“d.dd”) specifies a floating point numeric format for the preceding variable.

Figure 4.23 also shows interesting trends in the comparison of predicted and

average observed values for total phosphorus concentration.  Using the same color

coding scheme to represent predicted and observed concentrations, it can be seen that,

within the Mission and Copano subwatersheds, estimated concentrations generally

match the minimal levels that have historically been recorded there, between 0.1 and

0.3 mg/L.  However, in the Aransas subwatershed, observed concentrations

significantly exceed predicted levels.  In particular, observed concentrations just

downstream from the city of Beeville (Figure 4.24) are seen to reach above 7 mg/L,

whereas predicted concentrations in the same reaches of the river are less than 1 mg/L.
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These discrepancies would tend to indicate a significant point source in the area

contributing to total phosphorus loads.  Consultation with TNRCC personnel have

identified that the data points in question were sampled to investigate suspected

effluent problems from a wastewater treatment plant in Beeville.  However, it should

also be noted that most of these measurements were made within a short period in the

early 1980’s and it is not known whether total phosphorus at the sampling locations has

remained at these elevated levels.

4.6  Considering and Simulating Point Sources

As can be seen from section 4.5, the characterization of nonpoint source

pollution for a particular region may not provide a complete representation of the

pollutant levels in that area.  Point sources along stream networks can contribute

significantly to the measured pollutant levels.  Pollutant level data for point sources in

the San Antonio-Nueces Coastal Basin were unavailable at the time of this study.

However, a method of simulating point sources is investigated by considering the

difference between predicted nonpoint source pollution concentration levels and

observed concentration levels at a specific location, and then accounting for the

difference with a single point load at the location.  The point source pollutant load is

then included in every downstream location in the digital basin.

Estimating an Annual Point Load

Figure 4.24 shows a number of measurement points just downstream of

Beeville, TX where observed total phosphorus concentrations significantly exceed the

values expected from nonpoint sources alone.  Assuming that the Beeville wastewater

treatment plant effluent enters the Aransas River at the furthest upstream location

where a significant concentration discrepancy exists, a point source phosphorus

contribution for that location is estimated to account for the discrepancy.

To establish the exact value of estimated nonpoint source total phosphorus

concentration at the location, the phosconc grid is displayed in the Grid tool, overlaid

with the phopts coverage, and queried at the suspected point source location, using
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the Cellvalue command.  Similarly, the annual cumulative runoff grid is displayed and

queried to determine cumulative runoff at the point source location.  By multiplying the

cumulative runoff by the difference between observed and estimated concentrations,

the amount of observed annual phosphorus load attributable to the point source is

calculated.

Grid:  gridpaint phosconc value linear nowrap gray
Grid:  polygonshades phopts 2
Grid:  cellvalue phosconc *

The cell containing point (1223830.414,693729.621) has value 0.621
Grid:  gridpaint runoffac value linear nowrap gray
Grid:  polygonshades phopts 2
Grid:  cellvalue runoffac *

The cell containing point (1223830.414,693729.621) has value 5467914

Noting that the average observed total phosphorus concentration at the point

source location is 6.6 mg/L, the amount of this concentration attributed to the point

source effluent is calculated as 6.6 mg/L - 0.621 mg/L  =  5.979 mg/L.  By multiplying

this value by the cumulative runoff at the point source, the total annual estimated

cumulative phosphorus point load is determined as

5.979 mg/L  *  5,467,914 m
3
/yr  *  1000 L/m

3
  *  10

-6
 kg/mg  =  32,694 kg/yr.       (4-12)

This value for estimated load is compared with an algorithm from Thomann and

Mueller (1987), where load is calculated as the product of daily per capita municipal

flow, population of the municipality, and typical effluent concentration.  For Beeville,

using the population data from Table 1.1, and Thomann and Mueller’s typical average

values for per capita flow (125 gallons/capita-day) and total phosphorus municipal

effluent concentration (7 mg/L), this algorithm results in an estimate of

125 gcd * 13547 pop. * 365 d/yr * 3.785 L/gal * 7 mg/L * 10
-6

 kg/mg  =  16,376 kg/yr.    (4-13)

According to the Beeville wastewater treatment plant chief operator, daily flow

at the facility, averaged over the year, is approximately 2,000,000 gallons per day

(Barrera, 1996).  Using this value for flow, instead of Thomann and Mueller’s typical

daily per capita flow value, estimated total phosphorus load is calculated as
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2,000,000 gal/d * 365 d/yr * 3.785 L/gal * 7 mg/L * 10
-6

 kg/mg  =  19,341 kg/yr.      (4-14)

This value represents 58% of the value calculated in equation 4-12.  The fact that these

other estimates are within the same order of magnitude show that this method of

estimating point loads has some validity.  However, the other estimates also indicate

that the additional phosphorus loads contributing to the measured concentrations at the

Beeville location are probably not from the wastewater treatment plant alone.

Considering Point and Nonpoint Sources Together 

In order to combine the point source load from equation 4-12 with the nonpoint

source load, the point source load value is added to the cell where the observed

concentration discrepancy exists.  First, the flow accumulation grid is displayed and

overlaid with the phosphorus measurement location point coverage.  Through visual

identification of the discrepant Beeville measurement location and use of the

Selectpoint command, a single-cell grid representing the location is established.  This

grid has values of NODATA in all other cells.  So that map algebra may be performed

with this grid, the NODATA cells are converted to zero-value cells through use of the

Isnull command and the Con statement.  The annual point load value is simultaneously

stored into the selected cell.

Grid:  gridpaint ditfac value linear nowrap gray
Grid:  points phopts
Grid:  beepoint = selectpoint(ditfac,*)
Grid:  beeload = con(isnull(beepoint),0,32694)

A new cell-based loading grid is established by adding the existing nonpoint

source cell-based load grid (phosrnof) and the Beeville point load grid.  However, since

the Beeville point load grid is in units of kg/yr, it must first be converted to the aerial

mg-mm/L-yr units of phornof.  As shown in equation 4-15, this is accomplished by

multiplying the point load grid by 100.

Q * EMC (mg-mm/L-yr)  =  kg/yr * 10
6
 mg/kg * .0001 cells/m

2
 * .001 m

3
/L * 1000 mm/m  (4-15)

A new total phosphorus load grid is created as the weighted flow accumulation

of the new cell-based loading grid divided by 100, as per equation 4-6.  The
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phosphorus concentration grid is then recalculated as the new total phosphorus load

grid divided by the accumulated runoff grid.  A factor of 1000 included in this product

produces concentration in units of mg/L, as per equation 4-9.  As in section 4.5, a grid

of concentration values specific to the basin stream network is established using the

Con statement with the introfac grid.  The stream concentration grid is multiplied by

1000 to retain significant figures, the product is truncated to create the integer grid, and

the resulting grid is converted to a coverage, using the Streamline command.  The

mainland coverage is then used to clip the concentration coverage so that concentration

streams end exactly at the shores of the bay network.

Grid:  beernof = phosrnof + (beeload * 100)
Grid:  totpload = flowaccumulation(mainfdr,beernof) / 100
Grid:  totpconc = totpload / runoffac * 1000
Grid:  tophostr = con(introfac >= 1,totpconc)
Grid:  topholin = streamline(int(tophostr * 1000),mainfdr,grid-code)
Arc:  clip topholin mainland tophocon line

Since the beeload point source pollutant grid only affects load values along the

Aransas River, the only differences between this new concentration coverage and the

one created in section 4.5 occur along the Aransas.  Figure 4.25a shows the Beeville

portion of the newly calculated concentration coverage with the observed

concentration circles overlaid.  Likewise, figures 4.25b and 4.25c show portions of the

Aransas River between the Beeville area and the Copano Bay outlet.  A review of the

newly calculated concentrations in these three figures shows better agreement with the

average observed concentrations along the length of the Aransas River.  However, it

should be re-emphasized that this new concentration coverage is derived with the

assumption that the Beeville wastewater treatment plant effluent accounts for the

difference between observed concentrations and estimated nonpoint source

concentrations.  In fact, there may be a number of point sources along the Aransas

River that contribute to the total phosphorus concentration profile there.

For more accuracy, this method of simulating point sources should be

implemented with values of reported annual loads or permitted average concentrations

for all of the permitted point source effluents in the basin.
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4.7  Using an Optimization Routine to Provide Estimates of EMC Values

The land use expected mean concentration values included in Table 3.6 are

integral to this assessment of nonpoint source pollution.  As outlined in section 3.2,

these data are literature-based values used and published in a previous study (Baird, et

al., 1996).  Even though the agriculture and rangeland expected mean concentrations in

this study were established empirically from measurements made near the San Antonio-

Nueces coastal basin, it is desirable to establish a full set of expected mean

concentration data that fits local conditions in the basin and does not necessarily rely

on literature-based values.

One alternative method of determining expected mean concentration values for

each land uses involves the use of a computer-based optimization routine.  The input

data required for this routine are (1) average observed pollutant concentrations at

significant sampling locations, (2) all upstream pollutant point loads, (3) total annual

cumulative runoff at the sampling locations, and (4) the annual cumulative runoff

occurring from each land use upstream of each sampling location.

Determination of Optimization Routine Inputs

Average observed pollutant concentrations are established from the methods

discussed in section 4.5 and upstream point load data should be acquired from

reported or permitted values, as identified in section 4.6.  However, for this analysis,

the total phosphorus point load data estimated in section 4.6 is used.

Total annual cumulative runoff and land use-based cumulative runoff are

established for the TNRCC sampling sites where significant numbers (more than 15) of

historical phosphorus measurements exist.  There are five such locations in the San

Antonio-Nueces coastal basin; two along the Aransas River, two on the Mission River,

and one on Copano Creek.  Upon further review, one of these sampling locations, in

Copano Bay a few kilometers east of the Aransas River outlet, is rejected since

pollutant transport to the location does not follow a strict linear path along the stream

network and is assumed to have a significant dispersion component.

Determination of total annual cumulative runoff is accomplished by displaying

the cumulative runoff grid of the basin, overlaying the phosphorus sampling locations,
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and querying the locations of significant phosphorus measurements.  These steps are

performed using the Gridpaint, Points, and Cellvalue commands.  For a sampling site

along the Aransas River, the procedure is as follows:

Grid:  gridpaint runoffac value linear nowrap gray
Grid:  points phopts
Grid:  cellvalue runoffac *

The cell containing point (1252520.808,665484.913) has value 94664336.000

The cumulative runoff values for each land use upstream of a sampling location

are determined by first delineating a subwatershed from the sampling site, using the

Gridpaint, Points, Selectpoint, and Watershed commands along with the basin flow

accumulation grid, flow direction grid, and sampling sites coverage.  An equivalent

polygon coverage of the subwatershed grid is created, using Gridpoly.  The polygon

coverage is then used to clip the basin land use coverage, so that only those land uses

occurring upstream of the sampling location are retained.

Grid:  gridpaint ditfac value linear nowrap gray
Grid:  points phopts
Grid:  aranpt = selectpoint(ditfac,*)
Grid:  arptarea = watershed(clipfdr,aranpt)
Grid:  araptcov = gridpoly(arptarea)
Arc:  clip sanlu araptcov aranlu poly

The clipped land use coverage is converted back to a grid, using Polygrid.  Cells

in the land use grid are filled with land use category values (lusecat).  Finally,

cumulative runoff from each land use is established by using the Zonalsum command

with the land use grid and the cell-based runoff grid.  This command sums the grid cell

values from a target grid (runoff) based on regions of equal value defined in a zone grid

(land use category).  The result of this Zonalsum is multiplied by 10, as per equation 4-

1, in order to convert cumulative runoff to units of m3/yr.  The product is then

converted to an integer grid, so that a value attribute table may be subsequently created

for the grid.

Grid:  arlugrid = polygrid(aranlu,lusecat,#,#,100)
Grid:  arrunoff = int(zonalsum(arlugrid,runoff) * 10)
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By listing the value attribute tables (vat) of the land use grid and the cumulative

runoff grid, cumulative runoff values from each land use category in the subwatershed

are established by matching the values from the two tables, based on the count of cells

in each grid.

Grid:  list arlugrid.vat
Record VALUE COUNT
         1         11        1312
         2         12       1229
         3         13              6
         4         14        437
         5         16          25
         6         17          30
         7         20    65400
         8         30    25711
         9         40    35419
       10         50          19
       11         60          97
       12         70        866
Grid:  list arrunoff.vat
Record VALUE COUNT
         1      6730           6
         2    14420          19
         3    15100          25
         4    18450          30
         5  117060          97
         6  256980        437
         7  752240        866
         8  785360        1312
         9  906050      1229
       10            25114850    25711
       11              25536140    35419
       12            41141650    65400

Once this procedure is performed for each of the four significant sampling

locations in the basin, mass balance equations are set up for each subwatershed.  These

mass balances equate the total measured load (total cumulative runoff at the sampling

location multiplied by the observed concentration) with the sum of the loads from each

land use and point source.  The loads from each particular land use are denoted by

taking the product of the cumulative runoff from that land use and an expected mean

concentration variable associated with the land use.  Known point sources upstream of


